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1. INTRODUCTION 
 
NuclideNavigator-Pro is an extensive resource for nuclear decay and emissions data, elemental 
information, and a wide variety of standard unit conversions.  It is comprised of several interactive 
programs and reference materials which can be accessed from the Windows Start menu or from the 
main NuclideNavigator-Pro application interface as follows: 
 

 NuclideNavigator-Pro is the main application interface for the Chart of the Nuclides with a 
variety of ways to view, navigate, and query nuclear data provided in several databases 
compiled from various references described in Appendix A. Synthetic gamma-ray spectra 
in high (HPGe) and low (NaI) resolution detector response functions, and synthetic spectra 
of beta-, beta+, and alpha emissions are also available.  (See Section 2.) 
 

 The Library Lister is used to generate nuclear data reports based on a subset of nuclides 
selected from a master database.  (See Section 3.) 

 
 The Library Manager is used to create libraries compatible with standard ORTEC 

applications, such as GammaVision, or an XML format that may be used with other 
applications.  (See Section 4.) 

 
 The Decay Calculator provides several decay options including simple decay of a single 

nuclide, parent-daughter decay/build-up, full decay chains for a nuclide and its progeny, 
user-defined nuclide groups, and Cf-252 calculations.  (See Section 5.) 
 

 The Periodic Chart of the Elements provides an intuitive interface to view elements by 
physical form and chemical groups with easy access to basic physical properties.  (See 
Section 6.) 

 
 The Units Converter application is a simple tool to convert units for an extensive list of 

engineering and scientific parameters.  (See Section 7.) 
 
 Decay Schemes are provided in PDF format.  (See Section A.2) 
 
 A function for displaying synthetic spectra for an individual nuclide in the 

NuclideNavigator-Pro program and decay chain gammas in the Decay Calculator. 
 

Nuclear data from several references (See Appendix A) are included as Master libraries in the SQLite 
database format.  These files are in the directory C:\ProgramData\Ametek\Data Libraries by default.   
The legacy Microsoft Access libraries from the standard NuclideNavigator can also be used as Master 
libraries.  Modifications to the Master libraries are not recommended as changes could create 
incompatibilities with NuclideNavigator-Pro.  If changes or queries to the database are desired, then it 
is highly recommended to make a copy of the original databases before opening these files outside of 
the NuclideNavigator-Pro program.  An SQLite Database Browser program is available in the 
application directory for use by experienced database administrators to query and customize SQLite 
databases if desired. 



       

  

2. NuclideNavigator-Pro Chart of the Nuclides 
 
NuclideNavigator-Pro is the main program interface for the Chart of the Nuclides.  Nuclear data is 
provided in master libraries provided in the SQLite Database format or the legacy Microsoft Access 
Databases distributed with the standard NuclideNavigator program.  Links to the other utility programs 
and reference data provided with NuclideNavigator-Pro are also available from the associated menu 
and toolbar shortcuts. 
 

 
 
 
To get started simply select a library from the associated File menu or toolbar shortcut, adjust the 
display from the desired View menus, navigate the chart, and access library information using the 
following controls: 

 

1.  To the far left on the toolbar allows a direct jump to the specified nuclide.  The 
specified nuclide will be positioned near the bottom left in the General Electric and Karlsruhe 
Chart views, and near the top left in the TriLinear Chart views. 

 
 

2.  Shifts the displayed region of the chart diagonally along the "Ridge of Stability". 
 

1 
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3. Slider bars along the horizontal axis at the bottom of the window and vertical axis to the right of 
the window shifts the displayed region along the Neutron and Proton axes, respectively. 

 
4. While hovering over a nuclide in the chart the information bar at the bottom of the window 

displays the nuclide information and fission yields for that nuclide as a result of fission from the 
nuclide selected from the menu View\Fission Yields. 

 
 

 
5. Double-Click on an element box (to the far left of isotope boxes when the General Electric and 

Karlsruhe Chart formats are displayed) to access detailed information, such as as x-ray 
energies/intensities and elemental abundances.  Note that the element fields are not available with 
the Trilinear chart display.  (See Section 2.5.) 
 

6. Double-Click on a nuclide in the chart to access detailed information, such as gamma, beta, and 
alpha emissions, parents and daughtes, example spectra, and more. (See Section 2.6.) 

 
7. Tool Bar Shortcuts 

 Open Source Library (Same as File\Open Source Library menu) 
 

 Print Preview (See File\Print Preview menu) 
 

 Print Selected Region of the Chart (See File\Print menu) 
 

 Zoom In to View More Detail (See Tools\Zoom\In menu) 
 

 Zoom Out to View More Nuclides (See Tools\Zoom\Out menu) 
 

 Search the Data Library (See Tools\Search\Gammas (or Alphas) menu) 
 

 Periodic Chart of the Elements (See Tools\ Periodic Chart menu) 
 

 Units Converter (See Tools\ Units Converter menu) 
 

 Nuclear Decay Schemes (See Tools\Decay Schemes menu) 
 

 Decay Calculator (See Tools\Decay Calculator menu) 
 

 Library Manager (See Tools\Library Manager menu) 
 

 Library Lister (See Tools\Library Lister menu) 



       

  

2.1 File Menu 

2.1.1 Open Source Library 
Displays a standard File-Open dialog to browse to the desired library in SQLite database 
format (default for NuclideNavigator-Pro) or Microsoft Access database format 
(compatible with standard NuclideNavigator).  See Appendix A for information related to 
the reference materials associated with the database included with NuclideNavigator-Pro. 

2.1.2 Library Information 
Displays a brief description of the source data as well as the numbers of alpha, beta and 
gamma records contained in the database 
 

2.1.3 Recent Files 
Displays paths to recently opened source libraries which can be selected instead of using 
the Open Source Library browse dialog. 

2.1.4 Page Setup 
Opens a dialog box to set the paper size and source, orientation and margins for printing a 
portion of the nuclide chart. 

2.1.5 Print Preview 
Displays a preview of the current nuclide chart that can be printed. 

2.1.6 Print 
Displays a dialog box to select a printer, set properties, and print the currently displayed 
nuclide chart. 

2.1.7 Exit 
Closes the application. 

 

2.2 Tools Menu 

2.2.1 Zoom (In/Out) 
Decreases/Increases the number of nuclides displayed on the chart view. 

2.2.2 Search Library (Gammas/Alphas) 
Opens the Search Dialog with the search type set to Gammas or Alphas respectively.  See 
Section 2.8. 

2.2.3 Periodic Chart 
Opens the Periodic Chart of the Elements application.  See Section 6. 

2.2.4 Units Converter 
Opens the Units Converter application.  See Section 7. 



       

  

2.2.5 Decay Schemes 
Opens the Decay Scheme PDF file.  See Appendix A.2. 

2.2.6 Decay Calculator 
Opens the Decay Calculator application.  See Section 5. 

2.2.7 Library Manager 
Opens the Library Manager application. See Section 4. 

2.2.8 Library Lister 
Opens the Library Lister application.  See Section 3. 
 

2.3 View Menu 

2.3.1 Nuclides 
The Nuclide Chart can be set to display only the natural decay chains of 232Th, 233U, 
238U, and 235U to easily “walk” down these decay chains using the following options: 
 
 All Nuclides in the Library 
 Thorium (4n) Series (232Th Natural Chain) 
 Neptunium (4n + 1) Series (233U Natural Chain) 
 Uranium (4n + 2) Series (238U Natural Chain) 
 Actinium (4n + 3) Series (235U Natural Chain) 

 
The following is an example of the upper portion of the Thorium (4n) series: 

 
 

 



       

  

2.3.2 Fission Yields 
While hovering over a nuclide in the chart the information bar at the bottom of the window 
displays the nuclide information and fission yields for that nuclide as a result of fission 
from the selected nuclide.  Fission yield data is available for the following nuclides: 

 
 233U 
 235U 
 237Np 
 239Pu 
 240Pu 

 

2.3.3 Chart Format 
Display the Chart of the Nuclides in one of the following formats: 
 General Electric: Color scheme based on half-life and thermal neutron cross section. 
 Karlsruhe: Color scheme based on decay mode. 
 TriLinear Layout with Standard (General Electric) or Decay Colors (Karlsruhe) color 

scheme 
 

The Knolls Atomic Power Laboratory (KAPL) was operated by General Electric for more 
than four decades and in 19461, produced the first of fourteen editions of the Chart of the 
Nuclides, or as it came to be known as, the General Electric (GE) Chart.  While three more 
editions have subsequently been published by KAPL, under two different operating 
contractors, it is still often referred to as the GE Chart.  The GE format of proton number on 
the vertical axis and neutron number on the horizontal axis quickly became the standard 
configuration for most Charts of the Nuclides, along with the use of color to display 
additional information.  In this case, stable and naturally radioactive isotopes, as well as the 
magnitudes of a nuclide’s half-life and neutron cross sections.   

 
The Karlsruhe format was first published in 1958 by the Radiochemistry Institute in the 
Nuclear Research Center (Kernforschungzentrum Karlsruhe, GmbH).  It uses the standard 
layout (proton number on the vertical axis and neutron number on the horizontal axis) and 
color to indicate stable isotopes and the decay modes of radioactive isotopes.  
 
The Trilinear display was developed at the Oak Ridge National Laboratory (ORNL) in the 
late 1940's2 by W. H. Sullivan and published in 19573.  It is a unique way of looking at the 
chart of the nuclides where isotopes and isotones are diagonal, isobaric decay is vertical, 
and alpha decay is horizontal.  Either of the color schemes (half-life or decay mode) can be 
applied with this view. 
 
A full description of the color coding is available by selecting the Help - Legend menu 
item.  (Section 2.4.1) 

 
 

 
1 Nuclides and Isotopes, Chart of the Nuclides, Seventeenth Edition, Revised 2009,  E. M. Baum et al., Knolls Atomic 
Power Laboratory, operated by Bechtel Marine Propulsion Corporation. 
2 Trilinear Chart of Nuclides, William H. Sullivan, OR-WHS-2159 
3 W. H. Sullivan, Trilinear Chart of the Nuclides, 2nd Edition, (U.S. Government Printing Office, Washington D.C., 1957).  



       

  

                 
     General Electric Display Format          Karlsruhe Display Format 
 
 
 

            
Trilinear Format with GE Color Scheme           Trilinear Format with Decay Color Scheme 
 

2.4 Help Menu 

2.4.1 Legend 
 

The Legend Dialog contains tabs that dynamically change depending on the selected Chart 
Format as well as tabs for parameters that are independent of the chart format.   
 
The independent tabs include Nuclear Processes and Nuclear Reactions that demonstrate 
how to navigate the Chart of the Nuclides based on the specified processes, Binding Energy 
plots with a full view of all atomic numbers and a zoomed region for atomic numbers up to 
25, and a fission yield chart for U-233, U-235, and Pu-239. 



       

  

                    
                 Nuclear Processes                                       Nuclear Reactions 
 

                    
                  Binding Energy 1 <= A <= 25      Binding Energy 1 <= A <= 238 
 

                
                                   Fission Yields 
 



       

  

When the General Electric or Trilinear (Standard) Chart display is selected the Legend 
includes color codes for the following tabs: 
 

                      
                                        Stable          Naturally Radioactive 
 
 

                
                          Artificially Radioactive                Half Lives 
 
 

                     
                          Neutron Cross Sections                Independent Fission Yields 



       

  

 
When the Karlsruhe or Trilinear (Decay Colors) Chart display is selected the Legend 
includes color codes for the following tabs: 

 

            
                      Stable          Naturally Radioactive 

 
 

                  
                          Artificially Radioactive      Decay Modes 
 

                 
                            Decay Fractions 



       

  

2.4.2 About 
Displays the about page with acknowledgements as follows: 

 
 

 
 
 

       



       

  

2.5 Elemental Properties 
The Elemental Properties shown below are accessed by Double-Clicking on an element box (to 
the far left of isotope boxes when the General Electric and Karlsruhe Chart formats are 
displayed).   
 

                                     
 

2.5.1 File Menu 

2.5.1.1 Exit 
Closes the window. 

2.5.2 Edit Menu 

2.5.2.1 Copy All 
Copies all of the X-ray data to the clipboard. 

2.5.2.2 Copy All 
Copies only the selected X-ray data to the clipboard. 

2.5.3 Controls 

2.5.3.1 Return Button 
Closes the window. 



       

  

2.6 Nuclide Information 
The Nuclide Properties shown below are accessed by Double-Clicking on a nuclide in the chart. 
 

 

 
 
 
 

2.6.1 File Menu 

2.6.1.1 Exit 
Closes the window. 

 

 
 



       

  

2.6.2 Listing Menu 
Generates a report of the nuclide's information as shown in the example below with several 
of the fission yield and energy emissions omitted for brevity.  The content of this report is 
dependent on the Radiation Type button selected (Gamma, Beta, or Alpha).  The content 
may be saved to a file or printed from the File menu options, or copied to the clipboard 
from the Edit menu options. 
         

 



       

  

2.6.3 Options Menu 

2.6.3.1 View / Report 
Specifies the number of gamma and alpha energies to include in the nuclide 
information report generated from the Listing Menu.  Options include All energies 
or Top 5, 10, 15, or 20 based on branching ratio. 

 

2.6.3.2 Display Threshold Energy 
Displays a dialog box to enter a minimum gamma/alpha energy in keV.  Energy 
emissions less than the threshold energy are not included in the nuclide information 
report generated from the Listing Menu. 
 

          
 

2.6.4 Specific Activity Menu 
Displays a dialog showing the specific activity for this nuclide and element in Curies per 
Gram.  An optional mass may be entered to calculate the activity for the element or isotope. 

 

               
 



       

  

2.6.5 Controls 

2.6.5.1 Properties 
The properties section includes the nuclide half-life, natural abundance, and the 
thermal and resonance neutron capture cross sections (barns, if not otherwise 
noted) for the meta-stable and ground states. 
 

                                                        
 

2.6.5.2 Spectrum Button 
Displays a synthetic gamma, beta, or alpha spectrum depending on the Radiation 
button selected.  (See Section 2.7.) 

 

2.6.5.3 Radiation Buttons 
The selected button specifies the type of emission information displayed in the 
energy table, nuclide information reported from the Listing Menu, and the synthetic 
spectrum generated when clicking the Spectrum button. 
 

                     
 

2.6.5.4 Daughters and Parents 
Displays the Daughter(s) and branching ratio(s) of different decay modes and 
Parent(s) of the current selected nuclide.  Clicking on a daughter or parent nuclide 
will shift the current selection to that nuclide and allowing walking up or down a 
decay chain.  Note that Spontaneous fission (Sp-Fiss) is a special case that does not 
change the nuclide selection. 

 

                                                          
 



       

  

2.6.5.5 State Buttons 
Sets the state of the nuclide (ground, first meta-stable, second meta-stable, etc.) to 
be displayed. 
 

                    
 

2.6.5.6 Energy Emissions Table 
This table displays Gamma, Beta, or Alpha emissions based on the Radiation 
button selected as shown below.   

 

 
 

 
 

            
 
 

Click on the Energy (Gamma/Alpha) or End Point Energy (Beta) buttons to sort the 
table by ascending energy order. 
 
Click on the Branch (%) button to sort the table by descending Branching Ratio 
order. 
 
Click on the BR codes button to display a list of codes and their meanings. 
 
The A Gamma or Alpha 1 and A Gamma or Alpha 2 columns display associated 
gamma or alpha energies based on abundance/branching ratio.  Energies followed 
by “c” indicate that those gammas are emitted in cascade coincidence. 

 
 
 



       

  

2.7 Spectrum Viewer 
The spectrum view displays synthetic spectra for the specified emission type.  For gamma 
emissions the spectra can be displayed for both High Resolution (Germanium) and Low 
Resolution (Sodium Iodide) detector types.  See Appendix A.5 for methodologies employed for 
synthetic spectra. 

 

 
 
 

2.7.1 File Menu 

2.7.1.1 Exit Form 
Closes the window. 
 

2.7.2 Plot Options Menu 

2.7.2.1 Scale 
Sets the axis to Linear or Semi-Log scale. 
 
 

 
 



       

  

2.7.2.2 Display 
Sets plot display properties for grid lines and guidelines. 

2.7.2.2.1 Grid 
Set grid lines to None, Course, or Fine. 

2.7.2.2.2 Guidelines 
Optionally display vertical and/or horizontal lines across the plot based on 
the cursor (mouse pointer) location.  The options are enabled when 
checked and disabled when not checked. 

2.7.2.3 Drag 
Specifies spectrum navigation properties. 

2.7.2.3.1 Rubber Band Zoom 
Click and drag the mouse around a region of the plot to zoom in on that 
region.  To restore the display to the full spectrum, right-click and select 
"Original Dimensions". 

 

2.7.2.3.2 Vertical and Horizontal 
The spectrum is treated as a "window" that can be dragged vertically and 
horizontally. To restore the display to the full spectrum, right-click and 
select "Original Dimensions". 

 

2.7.2.3.3 Axis 
When enabled (checked) the range of each axis can be changed by 
dragging the mouse along the desired axis outside of the plot area. 

2.7.3 Help 

2.7.3.1 Graph Options 
Displays a dialog which indicates that Right-Clicking on the graph will show 
additional plot options. 

 

2.7.4 Right-Click menu 
Right clicking on the spectrum will display a menu of functions related to the plot area. 
 

2.7.4.1 Original Dimensions 
Returns the spectrum to full view after zooming or dragging.  
 



       

  

2.7.4.2 Show World Coordinates 
Displays the energy and counts at the cursor (mouse) location as it is moved over 
the spectrum. 

 

2.7.4.3 Print 
Prints an image of the spectrum plot to the specified printer. 

 

2.7.4.4 Copy to Clipboard 
Copies an image of the spectrum plot to the clipboard which can be pasted into 
documents that support graphics. 

 

2.7.4.5 Copy Data to Clipboard 
Copies the data set used to create the spectrum plot (energy/counts data pairs) to 
the clipboard.  This data set can be pasted into text documents or spreadsheet 
applications for evaluation. 

 

2.7.5 Controls 

2.7.5.1 Toolbar Buttons 
Scale, Grid and Drag buttons duplicate the related menu functions. 
 

2.7.5.2 Statistical Noise Checkbox 
Adds statistical noise variation from channel to channel when checked or smooth 
the spectrum data when unchecked. 
 

2.7.5.3 Return Button 
Closes the Window. 
 
 
 
 

 
 
 
 
 



       

  

2.8 Library Search 
The Library Search utility shown below is accessed from the menu Tools\Search Library 
(Gammas or Alphas) or the Toolbar Search button.  It is effectively a visual query tool with 
multiple parameters and criteria settings to limit the results to the most relevant information. 
 

                 
 
 

2.8.1 File Menu 

2.8.1.1 Select Prompt Gamma Library 
Standard File Open dialog is displayed to select the library used for prompt gamma 
searches.  This library is only used when the Prompt Capture Gammas option is 
selected. 
 

2.8.1.2 Exit 
Closes the search window. 

 

2.8.2 Search For Menu 
Sets the query criteria to either Gamma or Alpha emissions. 
 



       

  

2.8.3 Search Controls 

2.8.3.1 Generator Search Options 
Only nuclides generated by the generation processes that are checked will be 
returned in the data search. 

 

                                           
 

2.8.3.2 Energy (keV) and Window (+/- keV) 
Sets the energy range for the gamma or alpha peak search 

2.8.3.3 Match associated Lines 
This option limits the search results to only nuclides that emit up to two additional 
peaks in a specified range in addition to the primary target energy. 

2.8.3.4 Half-Life Search Options 
This option limits the search results to only those nuclides with half-lives within 
the specified Minimum and Maximum criteria. 

2.8.3.5 Additional Search Options Prompt Capture Gamma 
This option allows running a second independent search on a Prompt Gamma 
Library (gammas emitted immediately following the capture of a neutron) in 
addition to the main Source Library. 

2.8.3.6 Search 
Runs the search and displays the results as shown in Section 2.8.4.. 

 

2.8.3.7 Close 
Close the Library Search window. 

 
 
 

 
 
 



       

  

 

2.8.4 Search Results 
The search results are displayed in a report format as shown below.  If the Prompt Capture 
Gammas option was selected then independent search results from the specified database 
are shown after the primary search results. 
 

                  
 

 
The results can be saved to a text file or printed from the File Menu options or copied to the 
clipboard using the Edit menu options. 
 
Double-Clicking on a row in the search results will display the nuclide information dialog 
described in Section 2.6 for the nuclide on that row. 



       

  

3. Library Lister 
 
The Library Lister is a tool for reporting the emissions and properties of selected nuclides from a 
specified library.    
 

 
 

3.1 File Menu 

3.1.1 Open 
Displays a standard File-Open dialog to browse to the desired library in SQLite database 
format (default for NuclideNavigator-Pro) or Microsoft Access database format 
(compatible with standard NuclideNavigator).  
 

3.1.2 Library Information 
Displays a brief description of the source data as well as the numbers of alpha, beta and 
gamma records contained in the database 
 

3.1.3 Exit 
Closes the Library Lister application. 

 



       

  

3.2 About Menu 
Displays the Library Lister About page. 

 

 

 

3.3 Reporting Controls 

3.3.1 Nuclide List 

3.3.1.1 Add Button 
Add the name specified in the nuclide field to the list. 

3.3.1.2 Delete Button 
Remove the nuclide currently selected from the list. 

3.3.1.3 Clear Button 
Remove all nuclides from the list. 

 

3.3.2 Options 
These options specify the content of the Library Lister report   

 

3.3.2.1 Decay Mode 
Specifies the type of emissions reported (Gamma or Alpha energies). 

3.3.2.2 Sort Mode 
Specifies how the energy emission table will be sorted by Energy (ascending) or 
Yield/Branching Ratio (descending). 

3.3.2.3 Energy (keV) 
Optionally specify a minimum and maximum energy range to report. If unchecked 
all energy emissions are reported unless restricted by the Relative Yield criteria. 

 



       

  

3.3.2.4 Relative Yield 
Optionally specify a minimum Yield (Branching Ratio) for energies to report.  If 
unchecked all energy emissions are reported unless restricted by the Energy 
criteria. 

3.3.2.5 Nuclide Properties 
Optionally include (checked) or exclude (not checked) the specified nuclide 
properties. 

3.3.3 Process Button 
Generate a report based on the nuclide list and options specified as shown in the example 
below.   

              

 
 
The results can be saved to a text file or printed from the File Menu options or 
copied to the clipboard using the Edit menu options. 

 
 

 



       

  

4. Library Manager 
 
The Library Manager is used to create application specific libraries compatible with standard ORTEC 
applications, such as GammaVision, or XML formats that can be used with other applications.  The 
application is designed with Source and Target library windows as shown below.  Nuclides may be 
added to the Target library by simply selecting the nuclide from the Source list and dragging it with the 
mouse to the Target nuclide list.  The energies copied are based on the Radiation button selected 
(Gamma, Beta, or Alpha) and various options to control/limit the energies copied with the nuclide can 
be set in the Options/Preferences settings.  Once copied to the Target library, the nuclide and energy 
data can be edited, or nuclides and associated data can be entered manually if desired. 
       

  
 

4.1 Source Menu 

4.1.1 Open Source Library 
This menu has options for opening a library to be used as the Source.  Library types include 
Master Library (SQLite or Access database format) and Target Library (.LIB,.XML, and 
Access file formats).  Either option will display a standard File Open dialog to select the 
desired file type.  Alternatively, a library may be selected from the Recent Files menu. 

4.1.2 Library Information 
Displays a brief description of the source data as well as the numbers of alpha, beta and 
gamma records contained in the database. 
 



       

  

4.1.3 Nuclide Information 
Displays a report similar to the Library Lister for the nuclide selected in the Source list.  
The number and order of the emission lines listed are controlled by selections made on the 
Options/Preferences pages.  

 

4.2 Options Menu 
Displays the Preferences dialog which has three tabs (View/Print, Copy/Report, and Other) that 
match the Options submenus.  When selecting the submenus the respective tab is set as the active 
menu when the Preferences dialog opens.  The other tabs may be selected directly in the 
Preferences dialog after it is displayed. 

 
Note that the Preferences dialog can be accessed from both the Source and Target window 
menus. 

4.2.1 View / Print 
The Print Method selection specifies the order for displaying nuclides and peaks when 
displaying the Nuclide Information reports. 

 
The Sort Printed Gammas by selection specifies the sort order of energy emissions by 
energy (ascending) or Branching Ratio (descending) when the Print Method is set to Each 
Nuclide with its Gammas.  This selection does not affect the peak order when the Print 
Method is set to All Nuclides then All Gammas. 

 

                                    
 
 
 
 
 
 
 
 



       

  

4.2.2 Copy / Report 
The Number selection specifies how many energies will be included when copying a 
nuclide to the Target.  The Top N records are determined based on the highest Branching 
Ratios. It also specifies how many energies will be displayed on the Source Nuclide 
Information report.  It does not restrict the number of peaks displayed in the list of Source 
Gammas or the Target Nuclide Information report. 

 
The other options set prompts (or warnings) before copying nuclides that do not have 
energies of interest, automatically include daughter nuclides, and restrict which peaks are 
copied to the Target. 

 

                                      

4.2.3 Other 
This tab has an option to link the Source and Target windows so that they remain in a 
constant proximity to one another when either window is moved.  When this option is not 
checked the Source and Target windows can be moved independently without affecting the 
position of the other. 

 

                                      



       

  

4.3 Help Menu 

Displays the Library Manager about page. 
 

                      
 
 

4.4 Target Menu 

4.4.1 New Target Library 
Clears the Target Library editor fields and current file path.   

4.4.2 Open Target Library 
Displays a standard File-Open dialog to browse to a support library type (either ORTEC 
GammaVision .LIB or XML format).  Alternatively, a library may be selected from the 
Recent Targets menu. 

 

4.4.3 Save Target As... 
Displays a standard File-Save dialog to specify the file location and save the Target library 
to either the ORTEC GammaVision .LIB or XML format. 

 

4.4.4 Library Information 
Displays a brief description of the source data as well as the numbers of alpha, beta and 
gamma records contained in the database. 
 

4.4.5 Nuclide Information 
Displays a report similar to the Library Lister for all of the nuclides in the Target list.  The 
order of the emission lines listed are controlled by selections made on the 
Options/Preferences pages. 

 



       

  

4.5 Edit Menu 

4.5.1 Add Nuclide... 
Displays the following dialog where the new isotope name is specified.  When the Accept 
button is clicked the nuclide is added to the Target list. 

 

                                
 

4.5.2 Edit Nuclide... 
Displays the Nuclear Properties dialog to enter or modify nuclide data including the half-
life, nuclide type, uncertainty, reference source, nuclide flags, parent nuclides, and daughter 
nuclides and branching ratios.  The Nuclide Flags are the same as those used in ORTEC’s 
GammaVision software.  The Accept button is disabled until changes are made in one of 
the fields. 

 

 



       

  

 

4.5.3 Delete Nuclide... 
Deletes the selected nuclide in the list after acknowledging the following warning prompt. 

 

          
 

4.5.4 Add Gamma Ray, Beta, or Alpha... 
This menu changes to match the Radiation type button selected on the Source window, and 
displays the Add dialog for the associated type. 

 
The Branching Ratio is entered as a fractional value as opposed to a percentage. 

 
The 1st and 2nd Associated Energies (Gamma Ray and Alpha) and Average Energy (Beta) 
fields require a numeric entry even if only zero.   

 
The Photon flags are the same as those used in ORTEC’s GammaVision software.   

 
After data is entered click on the Accept button to store the peak data or Cancel button to 
close the dialog without saving. 

 

                     
 



       

  

4.5.5 Edit Gamma Ray, Beta, or Alpha... 
This menu changes to match the Radiation type button selected on the Source window, and 
displays the Edit dialog for the associated type. 

 
The Branching Ratio is entered as a fractional value as opposed to a percentage. 

 
The 1st and 2nd Associated Energies (Gamma Ray and Alpha) and Average Energy (Beta) 
fields require a numeric entry even if only zero.   

 
The Photon flags are the same as those used in ORTEC’s GammaVision software.   

 
After data is entered click on the Accept button to store changes. 

 
The << Previous and Next >> buttons can be used to navigate through peaks in the list 
without having to close the editor first. 

 
Click the Cancel button to close the dialog. 

 

                      
 

4.5.6 Delete Gamma Ray, Beta, or Alpha... 
This menu changes to match the Radiation type button selected on the Source window, and 
deletes the selected energies after acknowledging a warning prompt. 

.  
                                                          



       

  

4.5.7 Resort Gammas, Betas, or Alphas by 
This menu changes to match the Radiation type button selected on the Source window, and 
sorts the energy table Energy, Branching Ratio, or Sort Index as selected. 

 

4.6 Source Library Controls 

4.6.1 Nuclides 
All nuclides in the selected library are displayed in the list grouped by element with 
metastable states list after the ground state isotopes.  Enter a nuclide name in the Select 
field and click on the Go button to jump to that item in the list. Note that the dash ("-") is 
optional. 

4.6.2 Radiation 
Selects the emission type for the library manager.  Note that different libraries can be 
created for Gamma Rays, Betas, and Alphas, but only Gamma Ray libraries are generally 
used in conjunction with ORTEC’s GammaVision software. 

4.6.3 Energy List 
Displays emissions for the selected nuclide based on the Radiation type button selected.  
The list can be sorted by ascending energy or descending Branching ratio by clicking on the 
Energy and Branch buttons in this section. 

4.7 Target Library Controls 

4.7.1 Nuclides 
All nuclides in the selected library are displayed in the list and updated as nuclides are 
added manually or by dragging from the Source nuclide list. 
 
Right-Click on the nuclide list to display a menu to Add Nuclide, Edit Nuclide, Delete 
Nuclide, and generate the Nuclide Information report. 

4.7.2 Energy List 
Displays emissions for the selected nuclide.  The list can be sorted by ascending Energy and 
Index, or descending Branching ratio by clicking on the Energy, Branch, and Index 
buttons in this section.  When the list is sorted by Index, the Index value of a selected 
energy can be modified using the "^" and "v" buttons to move it up or down in the list.  
When establishing libraries for use in GammaVision, the peak order is important for 
optimal analysis results and that order is specified using the Index value. 
 
Right-Click on the energy list to display a menu to Add, Edit, Delete peaks. 
 



       

  

5. Decay Calculator 
 
The Decay Calculator provides several decay options including simple decay of a single nuclide, 
parent-daughter decay/build-up, full decay chains for a nuclide and its progeny, user-defined nuclide 
groups, and special treatment for the case of Cf-252. 
 

 
 
 

5.1 File Menu 

5.1.1 Open Source Library 
Displays a standard File-Open dialog to browse to the desired library in SQLite database 
format (default for NuclideNavigator-Pro) or Microsoft Access database format 
(compatible with standard NuclideNavigator). 



       

  

5.1.2 Library Information 
Displays a brief description of the source data as well as the numbers of alpha, beta and 
gamma records contained in the database. 

 

5.1.3 Listing 
Displays a report that contains a summary of the calculation and data used to generate the 
graph.  The calculation type and source of data is based on the tab selected in the bottom 
right panel and decay time specified.  The menu options in the Report window allow the 
data to be saved to a file, printed, or copied to the clipboard. 

 

5.1.4 Exit 
Closes the Decay Calculator application. 

 

5.2 Plot Options Menu 

5.2.1 Legend  
This menu is only displayed when the Decay Chain tab is selected in the lower right panel 
for decay calculations.  It has options to show the legend if it will not reduce the size of the 
chart beyond readability (Automatic), always display the legend (Show), or always hide 
the legend (Hide). 

5.2.2 Display 
Sets the axis to Linear or Semi-Log scale. 

5.2.3 Drag 
Specifies spectrum navigation properties. 

5.2.3.1 Rubber Band Zoom 
Click and drag the mouse around a region of the plot to zoom in on that region.  To 
restore the display to the full spectrum, right-click and select "Original 
Dimensions". 

5.2.3.2 Vertical and Horizontal 
The spectrum is treated as a "window" that can be dragged vertically and 
horizontally. To restore the display to the full spectrum, right-click and select 
"Original Dimensions". 

 

5.3 Spectrum Menu 
This menu is only displayed when the Decay Chain tab is selected in the lower right panel for 
decay calculations.  A synthetic spectrum is displayed in the Spectrum Viewer (Section 2.7) for 
the decay chain gamma rays in High Purity Germanium format. 

 
 



       

  

5.4 About Menu 
Displays the Decay Calculator about page. 

 

 
 
 

5.5 Chart Right-Click menu 
Right clicking on the chart will display a menu of functions related to the plot area. 

 

5.5.1 Original Dimensions 
Returns the spectrum to full view after zooming or dragging.  

 

5.5.2 Show World Coordinates 
Displays the coordinate data at the cursor (mouse) location as it is moved over the 
spectrum. 
 

5.5.3 Print 
Prints an image of the spectrum plot to the specified printer. 
 

5.5.4 Copy to Clipboard 
Copies an image of the spectrum plot to the clipboard which can be pasted into documents 
that support graphics. 
 

5.5.5 Copy Data to Clipboard 
Copies the data set used to create the spectrum plot (energy/counts data pairs) to the 
clipboard.  This data set can be pasted into text documents or spreadsheet applications for 
evaluation. 
 

 
 



       

  

 

5.6 Decay Time Controls 
The decay time can be set in minutes, days, or years with a consistent conversion of decay time 
to days which is used for all subsequent calculations. 
 
The decay time can be established using the Time Zero and Count Time calendar controls to 
determine the decay time in days.  These controls are useful when determining the decay of a 
reference source from a certification date to measurement date.  Fractional days can then be 
added to the decay time directly in the Days field to account for differences in the reference and 
measurement times if necessary. 
 
Select the Calculate button to update the decay calculations for the selected decay type. 
 

 

5.7 Decay Types 
The decay types are set by selecting the tabs in the lower right panel. 

5.7.1 Simple Decay 
This method is for a single nuclide which must be available in the Source library.  
 

 

 
 

Enter the starting activity at Time Zero and click the Calculate button to update the 
decayed activity at Count Time. 
 
If the decay time is subsequently changed then click on the Calculate button to update the 
decayed activity value. 

 
 



       

  

5.7.2 Parent-Daughter 
This method is for a calculating the activity of a parent nuclide and its daughter.  The parent 
nuclide must be available in the Source library, and list of available daughters established in 
the library will be available for selection. 
 

                                
 

Enter the starting activity at Time Zero for both the parent and the daughter, then click the 
Calculate button to update the decayed activity at Count Time for both nuclides. 
 
If the decay time is subsequently changed then click on the Calculate button to update the 
decayed activity value. 

 

5.7.3 Decay Chain 
This method is for calculating the activity of an entire decay chain starting with the parent 
nuclide. 
 

         



       

  

Enter the starting activity or mass of the starting nuclide at Time Zero, then click the 
Calculate button to update the decayed activity for all daughter products which will be 
displayed in the nuclide list. 
 
If the decay time is subsequently changed then click on the Calculate button to update the 
decayed activity value. 
 
The Sort Gamma Listing by Energy or Nuclide, Branching Ratio sets the format of the 
report generated from the File\Listing menu. 
 
The decay calculations are based on either the classic Bateman equations or the Amaku 
Matrix method.   
 
When using the Amaku Matrix method the initial activity of daughter products may be 
specified by checking the Other Activities checkbox.  When running the calculation, a 
dialog will be displayed to enter the initial activity of each daughter as desired.  Double-
Click on a nuclide in the list to set the Isotope, then enter the initial activity and click the 
Update button.  When the dialog is closed the decay calculation will result using the 
updated initial activities. 
 

                          
 



       

  

5.7.4 Group 
This method allows multiple nuclides and their initial activities to be loaded into a list for 
decay calculations of the entire group at the same time.  The results are included in the chart 
and the report generated from the File\Listing menu. 

 

    
 

Enter a nuclide name and activity then click the Add button to add it to the list. 
 
Click on an item in the list and click the Remove button to remove it from the list. 
 
After populating the list click the Calculate button to update the decay calculations which 
are displayed on the chart. 
 
If the decay time is subsequently changed then click on the Calculate button to update the 
decay calculations. 
 

 
 



       

  

5.7.5 Cf-252 
This method is for the special treatment of Cf-252 based on decay of certified sources. 
 

                               
 

Enter the activity percentages of each nuclide and the Cf-252 activity when it was certified.   
 

 
Click the Calculate button to update the following fields and the chart: 

 Initial Cf-252 neutron count rate 
 Decayed Cf-252 activity and neutron count rate 
 Total Decayed activity and neutron count rate for all Cf isotopes combined 
 Percentage of the total neutron count rate from Cf-252  

 
If the decay time is subsequently changed then click on the Calculate button to update the 
decay calculations. 

 
 

 



       

  

6. Periodic Chart of the Elements 
 
A standard periodic table of the elements that is connected to a small database of chemical and 
physical properties, as well as a brief history of each of the elements. 
 
The Periodic Chart of the Elements provides an intuitive interface to view elements by physical form 
and chemical groups with easy access to basic physical properties. 
 

 

 

6.1 File Menu 

6.1.1 Exit 
Closes the application. 
 



       

  

6.2 Help Menu 

6.2.1 Usage 
Displays the following dialog box with instructions for navigating the chart. 

 

                              
 

6.2.2 Legend 
Displays the following Legend pages which describe the chart color codes which indicate 
the element’s chemical group and the physical form of the element at room temperature. 
 

                               
 

6.2.3 About 
Displays the Chart of the Nuclides About page. 

 

                                
 



       

  

6.3 Navigation Controls 

6.3.1 Mouse Hovering 
Move the mouse pointer over an element box to update the selected element and physical 
properties box in the upper middle portion of the chart. 
 

       
 

6.3.2 Left Double Click 
Double click an element box to display the Chemical Properties dialog. 

 

                
 
 
 



       

  

6.3.3 Right Click 
Right click on an element box to display the "History" page for that element.  
 

      
 

 
 



       

  

7. Units Converter 
 
The Units Converter application is a simple tool to convert units for an extensive list of engineering 
and scientific parameters. 
 

                                               
 
 

7.1 Navigation  
Select the Conversion Type desired to update the applicable From and To units lists. 
 
Select the known quantity units in the From list. 
 
Select the units to be calculated in the To list. 
 

Enter the amount of From units and click the    button to display the amount in To units. 
 
 



       

  

Appendix A – References 

A.1 Nuclide and Emissions Data 

Erdtmann_Soyka 
The Gamma Rays of the Radionuclides, G. Erdtmann and W Soyka, Verlag Chemie, 
Weinheim, 1979. 

TORI-99c5x 
Table of Radioactive Isotopes, The Isotopes Project at LBNL, http://ie.lbl.gov/toi/ 
supplemented with: 

 Cascade coincidence data derived from ENSDF 
 Positron annihilation data from PC_NuDat-04 
 Fission yields, see below 
 Neutron cross sections, see below 

PC_NuDat-04 
National Nuclear Data Center, http://www.nndc.bnl.gov/ 

NuBase 2012 
Used to sort out the many inconsistencies in the NuDat 2.6 data,  
Chinese Physics C 36 (2012) 1157 - 1286,   
https:/www-nds.iaea.org/amdc/ 

NuDat 2.6 [10-21-16] 
National Nuclear Data Center, information extracted from the NuDat 2 database, 
http://www.nndc.bnl.gov/, and supplemented with: 

 Fission yields, see below 
 Neutron cross sections, see below 

RSICC-Prompt  
THERMGAM,   DLC-140, 1981, RSICC, Oak Ridge National Laboratory, 
https://rsicc.ornl.gov 

CapGam-2013 
National Nuclear Data Center, information extracted from the CapGam data, 
http://www.nndc.bnl.gov/capgam 
 



       

  

A.2 Decay Schemes 
The Isotopes Project at LBNL,   http://ie.lbl.gov.  Example page shown below. 
 

                     

A.3 Fission Yields 
T. R. England and B. F. Rider, LA-UR-94-3106, ENDF-349 

A.4 Neutron Cross Sections 
S. F. Mughabghab, M. Divadeenam and N. E. Holden, Neutron Cross Sections from Neutron 
Resonance Parameters and thermal Cross Sections, Academic Press (1981) 

A.5  Example Spectra 
Synthetic emission spectra for gamma rays and alpha particles are generated using algorithms 
developed by the author for typical HPGe and NaI sensors.  A significant amount of credit is 
due to the published works of, and private communications with Ray Gunnink. 
 
Beta particle shapes are generated using the equations associated with the standard (Fermi) 
theory of beta decay.  Coulomb corrections for positrons are non-relativistic point-charge 
approximations. Corrections for electrons are calculated using the equations from G. K. 
Schenter and P. Vogel, Nuclear Science 1983, Volume 83, page 393-396. 
 

A.6 Decay Calculation Methodology 
H. Bateman  The solution of a system of differential equations occurring in the theory of 
radioactive transformations,  Proc. Cambridge Phil. Soc., v.15 (1910) 423-427  
 
M. Amaku, P.R. Pascholati, V. R. Vanin, Decay chain differential equations: Solution through 
matrix algebra,  Computer Physics Communications 181 (2010) 21-23. 
 

A.7 Elemental Data 
Based on the “History of the Origin of the Chemical Elements and Their Discoverers” 
generated by Norman E. Holden, National Nuclear Data Center, Brookhaven National 
Laboratory 


